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Main Window Toolbar:
The most commonly used features of GroupWise can be quickly and easily accessed from the
GroupWise Main Window Toolbar. These features include sending Mail and creating new Appointments.
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GroupWise Main Window:
From the main work area in GroupWise you can access all of your GroupWise information
including your Email, Calendar, Appointments, Tasks, Notes, Folders, Documents and
Discussions. Each of the major components are described below.

Sent Items Folder:
This folder displays all
of the items you have
sent. You can also dis-
play the item properties
and perform actions on
each of the items.

Proxy:
Displays a list of all
users to whose mailbox
you have Proxy access.

Mailbox Folder:
All incoming items can
be accessed in this
folder. To change the
folder that specific
items are routed to, see
Rules.

Work in Progress:
When you are in the 
middle of the creation
of any GroupWise item,
choose Cancel and save
the item here so that you
can finish it later.

Task List Folder:
Displays a list of all the
tasks assigned to you or
that you have assigned
to others.

Unopened Item icon:
The envelope icon 
indicates that this folder
contains unopened
items. The numbers to
the left indicate your
unopened items.

Documents Folder:
Documents stored in you
GroupWise Library can be
found here. Contains two
sub-folders.

Item List: The contents
of the selected folder
are displayed in the Item
List. You can sort the
list by clicking on the
desired column heading.

Calendar Folder:
The GroupWise Calendar
displays your calendar in
either a Daily, Weekly,
Monthly or Yearly format.
All your Appointments,
Notes, and Tasks assigned
on their designated
dates.

Toolbar:
The most frequently used
GroupWise features can be
accessed from the Toolbar.
See the Toolbar bellow 
for more information 
concerning each item.

Cabinet: 
Create Personal, Shared,
Find, NNTP and other
folders here to quickly and
easily organize all your
GroupWise items quickly
and easily.

A. Display: Change the display of the 
selected folder’s Item List box.

B. Access Mode: Choose between 
Online, Caching, and Remote modes 
for connecting to your master
mailbox.

Tool Buttons:
C. Address Book: Open your GroupWise 

Address Book.
D. Item Properties: Display the detailed 

properties (date received, opened, 
deleted, etc.) for the selected item.

E. Print Calendar: Print your calendar in 
one of several different formats.

F. Find in GroupWise: Search for any 
item in GroupWise.

Item Create Buttons:
G. Create New Mail: Select to Create 

and send a new Mail Message.
H. Schedule New Appointment: Select to Create a 

new Scheduled Appointment.
I. Create New Task: Create and send a

new Task.
J. Create New Document: Create a new 

Document.

View Buttons
K. Select View Type: Choose display method for the

Items List, Details( ), Discussion threads ( ),
or Calendar ( ).

L. Turn QuickViewer On or Off: Displays the 
GroupWise QuickViewer in the lower half of the 
Main Window.

M. Open Calendar View: Opens a separate Calendar
window with the desired Calendar View.

www.gwtools.com



Performing Other Actions on Mailbox Items
1. Select the Mailbox ( ) folder in the folders list or any other desired folder.
2. Right-click the desired item.
3. Choose the desired action:

Replying to a Message
1. Open your Mailbox by clicking the Mailbox folder
( ) or the folder where the desired message is found.
2. Double-click the desired message.
3. Click the Reply button ( ).

4. Select Reply to sender to send your reply only to the person who sent the 
message to you. Select Reply to all to send your reply to the sender and all persons 
who also received this message.
5. Compose your reply.
6. Click Send ( ).

Open the item into its own window.
View the item using the GroupWise Viewer.
Save the item and/or attachment(s) outside of GroupWise.
Print the item and/or attachment(s).
Apply a Filter to the selected folder using the sender’s name as 

the filter criteria.
Dial Sender’s phone number (only works if you have a phone 

connected to your computer).
Send a Reply to the sender and/or to all other recipients.
Forward the item to any desired recipient. Message is Forwarded

as an Attachment to desired recipient.
Delete the item and move it to the Trash folder.
Delete the item and immediately Empty it from the Trash.
Change the item to another type of GroupWise items so that it 

displays differently (ie. Appointment, Note, Task, etc).
Move the item into your GroupWise Archive.
Mark the item either Read or Read Later.
Check a document back into the GroupWise Library
Navigate to the next or previous Unread item.
See detailed item Properties including the creation date, 

file sizes, and other options.

Using the Mailbox
All GroupWise items, by default, are stored in your mailbox folder. You can read/open the
message, delete, forward, reply and perform other actions on each incoming item.
To organize your items further, you can create subfolders (See Folders) and manually or 
automatically move items from your Mailbox to those customized folders.

Opening and Reading Items

1. Select the Mailbox ( )
folder in the folders list.
2. Double-click an item in the 
Mailbox to open it.
or
Right-click the desired item
and select Open.
3. When you have finished reading
the item, select Close ( ), to close 
the message and keep it in your
Mailbox.
Or
Select Delete ( ) to close the item
and move it to your Trash folder.
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Sending Email
Creating a new Email message
1. Click the Send New Mail icon ( ) on the Toolbar.

3. Press the Tab key to move to the Subject: field and enter the subject for your message.
4. Press the Tab key to move to the Message: field and enter the details of your message.
5. Click the Send button ( ) to send your message.

Spell Checking a Message
1. After finishing your message (Email, Appointment, Note, Task, etc.) click the Spell
Check icon ( ) on the message Toolbar.

2. When the Spell Check finds misspelled words, you can select one of the following options:
Replace word with the selected spelling of the word.
Skip Once to skip this instance of the word without change.
Skip Always to skip every instance of this word in this message.
Add to add this spelling to the GroupWise dictionary.

3. After the entire message has been checked, (GroupWise will indicate completion of the task)
click Yes to close the Spell Checker.

Forwarding a Message
1. Open your Mailbox by clicking the Mailbox folder ( ) or the folder where the desired
message is found.
2. Double-click the desired message.
3. Click the Forward button ( ).
4. Enter the recipient(s) you want to receive the forwarded message.
5. Add a message in the Message field (if desired).
6. Click Send ( ).
The original message is sent as an attachment.

Opening an attached file

1. Open the message with the
attached file.
2. Attached files are displayed in
the lower portion of the message
window.
3. Right-click the attached file and
select the desired action.

View Attachment: Use 
GroupWise’s viewer to see the 
attachment.
Open: Open the attachment in 
the associated application.
Save As: Save the attachment to 
your desired location.
Print: Print the attachment to 
one of your printers.

2. Type the recipient’s name(s) in the
To: field (e.g., Andy Taylor), if the
recipient is an internal employee 
or their entire Internet address 
(ataylor@mayberry.com), if the recipient
is outside your organization. Note: If you
desire to send the message to more
than one recipient, type a comma (“,”)
after each recipient’s name.
or
Click the Address Book icon ( ) to
open your address book and select the
recipient(s) from the appropriate book
(See Address Book for details 
concerning use of the GroupWise
Address book).
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Attaching a File to any Message
1. Open the type of item you wish to send (New Mail, New Appointment, New Task, etc.)
2. Click the Attach button ( ).
3. Locate the file to be attached using the standard Windows Attach File dialog box.
When the file is located, select the file using the left mouse button.
4. Click the OK button to attach the file.
5. Repeat steps 2 through 4 until all desired files are attached.

Creating a Routing Slip
1. Click the Send New Mail icon ( ) on the Toolbar.
2. Select Actions menu.
3. Select Routing Slip.

Message Priority and other Options
1. Click on the Properties icon ( ) on the toolbar.

4. Enter each recipient’s name in the
order you want the message delivered, fol-
lowed by a comma (“,”). Note: To change
the recipient order, click and drag the
name to the new location.
5. Complete the message and click 
Send ( ).
The message is delivered in the order
appearing in the route. Once a recipient
has completed the item, they must mark it
“Completed” so that it will be moved on to
the next recipient. Deleting a routed item
prior to marking it completed terminates
the route and the item will not move on to
the next recipient.

Change tracking level that is 
displayed in Sent Items.

Set Classifications such as “Top Secret”,
“Proprietary”, etc.

Set Priority Level: High, Standard or Low.

Recipients are requested to reply before
deleting the item.

Message will not be delivered until 
selected date.

GroupWise Calendar
1. Display your GroupWise Calendar by clicking on the Calendar folder ( Calendar)
in the Folder List box.

Double-click any item to
open the details for that

item.

Click and drag any appoint-
ment to a new time or date

to reschedule.

Right-click any item to perform 
various actions, such as Accept,

Decline, Delegate, set an Alarm, etc.

Double-click any free space to 
schedule a personal Appointment,

Note or Task.

Check box to mark a
Task as being completed.

Select date to display
Appointments, Notes

and Tasks for that day.

Padlock icon indicates
that the item has been

marked Private.
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Scheduling Group Appointments
1. Click the Schedule New Appointment icon ( ) on the GroupWise Toolbar.
2. Type the names and resources you want to schedule in the To: field or click the Address
button ( ) to open your Address Book and select the users and resources you want to
schedule for your meeting. (See Address Book for additional information.)
3. Press the Tab key to move to the Place: field and enter the location of the appointment.

NOTE: If you scheduled a Place Resource, the Place field will be automatically filled in.

4. Select a Start Date and Start Time for the appointment. You can click the appropriate
icons to bring up the Start Date and Time Input windows.
5. Press Tab to move to the Subject and enter an appropriate subject for the meeting.
6. Enter any necessary information in the Message field and add any necessary
Attachments, then click Send ( ). (See Attaching a File to a Message for more information).

Performing a Busy Search
1. Individually select the people or resources that you want to scheduale an appointment
with, then click the Busy? button to show available dates & times.

2. After selecting an ideal date and time for your meeting, click OK to close the Choose
Appointment Time window and continue scheduling your appointments (steps 3 - 6 covered
in the Schedule a Group Appointment section).

Scheduling recurring Appointments, Tasks and Notes
1. Create a new Appointment, Note or Task from the GroupWise Toolbar ( ).
2. Click the Set Date icon ( ) to open the Set Date window.
3. Click the Auto Date button to open the Auto Date window.
4. Create the recurring item based upon the following methods:

5. Click OK to accept the selected recurring dates.

Click Invite To Meeting
to add additional

users/resources to this
appointment.

If you have been given
“Read” rights to an 

individual’s appointments,
details will be displayed here.

Available Times
displays those times when all

selected persons and
resources are free.

Click Auto-Select to have
GroupWise automatically

select the first date and time
when everyone is available.

Currently selected Date
and Time for your

appointment.

Drag the Date/Time
selection box to the

desired date and time.

Example method allows you illustrate
the autodate. This example creates an
appointment. on every Mon., Wed., Fri.

from May through August.

The Formula method requires you to
create a formula to generate the

desired dates.

Choose the Dates method to select
the desired dates of the recurring

appointment.
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Accepting Appointments, Notes and Tasks
When you receive an Appointment, Task or Note, you can accept or decline the item to let
the sender know if you will be able to fulfill the request. (All Appointments, Tasks and
Notes appear both in your Mailbox and on the scheduled day.)

1. Click the Mailbox or Calendar folder.
2. Double-click an Appointment, Task or Note.
3. Click Accept ( ) or Decline ( ).
4. If you are accepting an appointment, select an option under Show As.

Free: You want the event on your calendar, but you show that you are available to be 
scheduled for other events.
Tentative: You will probably attend the event, but other events may take precedence.
Busy: You will attend this event and are not available for other appointments.
Out of Office: This event is off-site.

5. Type a message in the Comment text box and click OK.
The sender can read your comments in the Properties view.

Printing your Calendar
1. Click Print Calendar ( ) on the GroupWise Toolbar.
2. Select the Desired Calendar Format.
3. Select a Form size. Available options depend on the calendar type selected.
4. Select the desired form from the Available forms list box. Available options are
dependent upon the selected format.
5. Select a Form orientation.

NOTE: You will see a thumbnail sketch of the calendar in the view box on the right. You
can also click Preview to see the layout in detail.

6. Select the Content tab
7. Specify the first date you want to print in the Starting Date box, then specify the num-
ber of days you want to print in the box to the right.
8. Select what information you want printed in the Content section.
9. Specify the Display options you want printed.
10. Select the Options Tab and specify the options you want.
11. Click OK twice and then click Print.

Multi-User Calendar
1. Display your GroupWise Calendar by clicking on the Calendar folder ( Calendar)
in the Folder List box.
2. Select the Multi-User tab.
3. The first time you select the Multi-User calendar view, you must select the users whose
calendars you wish to view (See Proxy for details concerning what needs to be done for
you to see others’ calendars, as well as for others to see yours).

Click to jump back
to the current date.

Select the items you
want to see.

Click the arrows,
month, day or year
to change dates.

Click to add/remove users
from your Multi-User

Calendar view.

Double-click any item to open
the details for that item.

Double-click any free area to schedule
a personal Apptointment, Note or

Task for that person.
(NOTE: They must have given you 

“Write” rights to do this.)

Click + or - to increase or
decrease the number of

columns displayed.
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If you need to remove a name from the Address Listbox, simply double-click on
the name.

Sharing GroupWise Folders
1. Right-click on your Cabinet and choose New Folder.
2. Select Shared Folder and click Next.
3. Give the new folder a name and click Next.
4. Enter each user’s name with whom you want to share this folder and click Add User.
Repeat until all desired users are in the Share list.

5. Click Next.
6. Define the Display settings for this folder and select Next.
7. Enter desired Message to the recipients of the newly shared folder. 
8. Click OK.

NOTES: Any item in this folder is available to
everyone with access rights granted to them.
You can right-click the folder and choose
Sharing to grant new users access, modify
existing users’ access or remove
a user from the access list.

You can also change the View by: settings
to Discussion Threads to clearly view 
discussions that take place in this new
shared folder.

Address Book
The GroupWise Address Book is used to quickly select users, resources and groups from a
list when addressing items to send. The Address Book is also ideal for looking up details like
phone numbers, addresses and other pertinent individual information.

The Novell GroupWise Address
Book contains all the users

within your organization. Only
the system administrator can

modify this information.

Double-click user, group or
resource entries to add them to

your address list.

Use the Frequent
Contacts tab in the

Address Book to access
your most frequently

used addresses.

You can create, edit, and save any number of 
personal address books. You have full rights to add
and delete name and address information for any

person, company, or resource you want in your 
personal address books.

If you send regular messages to the same
group of people, address those people,
click Save Group, then name the group.

Information provides
specific user details.

Remove a user from the
Share List.

Select to add users using
the Address Book.

Select a user and
modify his/her

Additional access
rights.
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Creating and Using Discussion Threads
To Create a New Discussion:
1. Create or open a Shared Folder (See Organizing Messages for details).
2. Select File > New > Discussion .
3. Enter a Subject for the discussion.
4. Press the Tab key and enter details in the Message field.
5. Click Post ( ).
All persons who have access to the selected shared folder will instantly see the new discus -
sion item.

To Display items in a Folder as a Discussion:
1. Right-click the desired Folder.
2. Select Properties , then click the Display tab.
3. Change the View by list to Discussion Thread.
4. Click OK.

Proxy
Proxy allows you to grant someone else in your organization the rights to see your
Appointments, Notes, Tasks, Mail Messages, etc., as well as send items out as if you sent
them yourself.

To Grant Someone Rights to your Mailbox:
1. Click Tools > Options .
2. Double-click the Security icon ( ) and select the Proxy Access tab.
3. Select the persons you want to receive access by typing their name(s) and clicking Add
User or by using the Address Book ( ).
4. Place a checkmark next to the right(s) you want to grant.
5. Click Apply then click OK.

To access someone’s mailbox who has granted you Access:
1. Click the Proxy icon ( ).
2. Click Proxy...
3. Select the user whose mailbox you want to access from the Proxy List or add a new user
to the list by entering their name and click OK.

Your GroupWise window(s) will now reflect what is in the other person’s mailbox. NOTE: You
will see only those items you have been granted rights to see.

Notify
The GroupWise Notify program informs you of incoming items and sound alarms for
upcoming appointments. When Notify is running and you receive a new item, an envelope
displays over the Notify icon on the Windows System Tray ( ).

Running Notify:
1. Click the Windows Star t menu ( ) then select Programs > GroupWise > GroupWise
Notify.

Specifying How You Are Notified:
1. Right-click the Notify icon ( ) on the taskbar and select Options .
2. Click the tab you want to change and customize Notify to your liking.
If you click the Notify tab, you can specify how Notify aler ts you when you receive different
types of items in your Mailbox.
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